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Starting to use Microsoft Excel

When you start working in MSExcel2000, you begin by using a workbook that contains pages called worksheets. They are identified along the bottom of the screen as Sheet1, Sheet2, and so on.

The most recognizable difference between a word-processing document and a spreadsheet is that the spreadsheet uses rows and columns because most data entered onto a spreadsheet is numerical and is easier to read, understand, and manipulate when presented in columns.
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Change the cell contents to bold, italics or underline.
	Use these buttons to add Web links, calculate an AutoSum, add formulas, and sort data.
	The Chart Wizard helps you create charts.
	The Drawing Tool helps you create WordArt and add shapes to worksheets.

	
Merges multiple cells and then centers text in the cell.
	
	
Use these buttons to format numerical data.
	



Moving around in the Excel 2000 workbook

There are a number of ways to move around in a workbook. Moving from one cell to another in Excel 2000 is quick and easy. The ways to move from cell to cell include clicking a cell or using the Go To command, the scroll bars, the arrow keys, or the HOME, END, PAGE UP, and PAGE DOWN keys.

To move within a worksheet

· To select any cell, click it. For example, click cell A1.

· To move one cell to the right, press TAB, or to move one cell to the left, press SHIFT+TAB.

· To move one cell down, right, up, or left, use the arrow keys. 

· To move to the uppermost-left cell, A1; press CTRL+HOME.

· To move to any cell, on the Edit Menu, click Go To and then type any cell number (for example, J18).

· To move down in the worksheet, press PAGE DOWN.

· To move up in the worksheet, press PAGE UP.

· To move to the first column of the worksheet, press HOME.

To adjust column widths

When “#######” appears in a cell, the cell is too narrow for the data to be displayed. To solve this:

1. Select the columns in your worksheet by clicking the A column header and dragging across to the last column in which you have dates entered.

2. Move the pointer over the border between any two-column headers until the pointer changes to a double arrow.

3. Double-click. The columns automatically adjust the width to the longest text in their respective columns. 

On the File menu, click Save As and type an appropriate name in the File name box.

Insert and adjust a row in a worksheet

1. Select the row number on the left of the screen above the row that you want to insert a new row to.

2. Click on Drop Down Menu Insert and click in menu option Row.

3. When the row appears, move the mouse arrow over the line directly underneath the row number of the row you want to adjust the size of.  The mouse arrow should change to one with a line and two arrows pointing up and down.

4. When this mouse cursor appears click and drag the mouse to adjust the column.  Notice a numeric value appears stating the height of the row.

Text and Cell Formatting

To change how text, a cell or a group of cells appears on the screen do the following:

1. Click on drop down menu Format and click on menu option Cells . . .
2. In the dialog box that appears click try the following:

a. Click on tab Format for text changes – change the currency and decimal places to express a number as a money.

b. Click on tab Border for cell border changes – make the table border thicker than the cells borders.

c. Click on tab Pattern for cell shading/cell colour changes – change table headings to light grey.

Creating a worksheet to calculate data

A worksheet can also calculate data when you add formulas. Formulas in worksheets can save you time by doing many of the tedious calculations involved in recording vast amounts of parts and labour costs throughout a week month or year. 

Enter a formula that contains a function
1. Click the cell in which you want to enter the formula.

2. To start the formula with the function, click the ‘=’ sign (Edit Formula) in the formula bar.

3. Click the down arrow next to the Functions box.

4. Click the function you want to add to the formula. If the function does not appear in the list, click More Functions for a list of additional functions. Notice the formula palette changes to assist with the chosen function.

5. Enter the arguments (the parts of the function).

6. When you complete the formula, press ENTER.

The Formula Palette


Tips 

· You can enter the same formula into a range of cells by selecting the range first, typing the formula, and then pressing CTRL+ENTER.

· You can also enter a formula into a range of cells by copying a formula from another cell. 

Adding formulas to your mechanics weekly job tracking worksheet

Adding formulas to your worksheet will be the most difficult part of generating results. You can add formulas that add quantities and currency values, calculate percentages, and generate averages.

In order to see the formula work, you must have numbers in the cells representing labour costs, parts costs and quantity of jobs done throughout the week.

To add a formula for totals 

1. Click on the cell that the result is to go into.

2. Click the Edit Formula button (the = sign).

3. Click the Name Box drop-down list and then click SUM. 

4. In the Number 1 box, type the range of cells to calculate

5. Click OK.
Notice that the formula itself shows in the formula bar when the cell is selected. To modify or change the formula, simply click in the formula bar, make the changes, and then press ENTER.

nb: You have the total for the days work, but you need the sum for the other day. You could type the formulas individually into the appropriate, but that would take some time and you might make some mistakes. Excel 2000 can make it very easy for you.

6. To fill all of the other cells, select the cell where the total is, place the cursor on the small square in the lower-right corner of the cell, and drag to the last cell in the row. Excel 2000 not only copies the formula into each cell, but also adjusts the formula for each column so that it is correct for that column of numbers.

To add a formula for percentages

1. Click cell below the Average cell.  You need a formula here that divides the number of jobs on one day by the total of all jobs. Then you'll convert it to a percentage.

2. For example type =B7/$B$7 (the cell with the total divided by the constant total in cell B7).

3. Press ENTER. The number 1 appears in cell B7.

4. To change the number to a percentage, click cell C7 and then on the Format menu, click Cells.

5. Click the Number tab. In the Category box, click Percentage.

6. In the Decimal Places box, type 1.

7. Click OK. You should now see 100.0% in cell C7.

8. Now, just as you copied the formulas earlier, you drag the fill handle to copy the formula in C7 to the rest of the column. Because you used $B$7 instead of B7, the number does not adjust to the total in the column in which you are working. To find out more about constants, ask the Office Assistant.

9. Save your work.

Creating letter grades from percentages

Now that you have calculated averages, you can easily figure letter grades from scores using Excel 2000. For this type of formula, Excel 2000 compares data using a formula that evaluates the data in relation to a table that you create. The formula interprets the range of data and assigns the value, or letter grade, you have associated with that number. So, you will have a formula that looks up the value you have assigned, and places it in the cell you want. This is called a lookup table. You will first need to create the table that the formula looks at, then assign the formula to the letter grade cells.

Creating a chart with the Chart Wizard

Presenting information in a chart can be a very effective way of communicating numerical data that otherwise might be too confusing or complicated. Since most people are highly visual, a chart added to text can really catch the audience's attention and help to inform and persuade them more thoroughly.

The Chart Wizard shows each step along the path from entering raw data to completing a graph. You can transform numbers into graphs, illustrating the power of visually oriented information to strengthen presentations.

To use the Chart Wizard

1. Open the Grade Book workbook.

2. Select the test data in the Grade Book worksheet, including the headings and student numbers, but not the main title or totals (cells B8 through F13).

3. On the Standard toolbar, click Chart Wizard.

4. On the Standard Types tab, in Chart type, click Column.

5. In Chart sub-type, click Clustered column with a 3-D visual effect.

6. Click Press and hold to view sample to see a sample of your data in the clustered column 3-D format.

7. Click Next twice.

8. In the Titles tab, in Chart title, type Test Grades.

9. In the Category (X) axis, type Student Numbers.

10. In the Value (Z) axis, type Points. (The Z-axis title is available but the Y-axis is not, because it extends back into the chart.)

11. Click the Gridlines tab to select type of lines to show on your graph.

12. In Category (X) axis, clear the Major gridlines check box.

13. In Value (Z) axis, select Major gridlines.

14. To move the legend to the bottom, on the Legend tab, click Bottom.

15. Click Next for Chart Location.

16. Click As new sheet.

17. Click Finish to complete the chart process.

Attaching the graph as a new worksheet makes it easier to print a chart. You now have a readable and easy-to-understand chart. Attaching the chart as an object has the advantage of providing an immediate view of changes to the chart as you change the data.

Enhancing chart titles

Rotating the Z-axis title gives the chart more room. The main graph title is easier to read with a larger font size. Here's how to change them.

To rotate Z-axis titles and enlarge chart titles

1. In the chart from the previous activity, click the chart title (Test Grades).

2. On the Formatting toolbar, change the font size to 20 point.

3. Right-click the Z-axis title (Points).

4. Click the Format Axis Title dialog box.

5. On the Alignment tab, click the text line, and drag it up to the top of the semicircle to 90 degrees.

6. Click the Font tab and then change the font to bold and 14-point.

7. Click OK.

8. Right-click the X-axis title (Student Numbers).

9. Click Format Axis Title.

10. Click the Font tab and then change the font to bold and 20-point.

11. Click OK.

Changing colors of data bars

You can also change the data bar colors to enhance your chart or to draw attention to information. Perhaps you want to draw attention to the most recent test so students can easily compare this score with previous test scores.

To add colours to enhance data bars

1. Right-click the first data bar.

2. Click Format Data Series.

3. On the Patterns tab, click Dark Green in the fourth row.

4.  Click OK.

5. Right-click the second data bar and change the color to Dark Blue.

6. Right-click the last data bar and change the color to Yellow. The brighter color in the last bar calls attention to that bar.

Rotating charts

Sometimes it is easier to understand a chart if it is viewed in 3-D. Using Excel 2000 you can modify your chart to show it from any view—top, bottom, right, left--or you can create 3-D charts.

To rotate a chart

1. Right-click in the center of the chart.

2. Click 3-D View.

3. In the Elevation dialog box, type 15.

4. In the Rotation dialog box, type 40.

5. Click the Auto scaling and the Right angle axes boxes.

6. Click Apply.

7. Click OK, and save your work.

Appendix A: Using functions to calculate values
Functions are predefined formulas that perform calculations by using specific values, called arguments, in a particular order, or structure. For example, the SUM function adds values or ranges of cells, and the PMT function calculates the loan payments based on an interest rate, the length of the loan, and the principal amount of the loan.

Arguments   Arguments can be numbers, text, logical values such as TRUE or FALSE, arrays, error values such as #N/A, or cell references. The argument you designate must produce a valid value for that argument. Arguments can also be constants, formulas, or other functions. For more information about using a function as an argument for another function, also known as nesting functions, click 

.

Structure   The structure of a function begins with the function name, followed by an opening parenthesis, the arguments for the function separated by commas, and a closing parenthesis. If the function starts a formula, type an equal sign (=) before the function name. As you create a formula that contains a function, the Formula Palette will assist you. For more information about using the Formula Palette, click. For more information about how to enter a formula that contains a function, click 

You can use any of the following functions to summarize data in a list. Click the function you want in the Use function box in the Subtotal dialog box (Data menu, Subtotals command).


Appendix B: Glossary of functions

Summary Functions

	Use this function
	To summarize

	Sum
	The sum of the values in a list. This is the default function for numeric data.

	Count
	The number of items in a list. This is the default function for nonnumeric data.

	Average
	The average of the values in a list.

	Max
	The largest value in a list.

	Min
	The smallest value in a list.

	Product
	The result of multiplying all the values in a list.

	Count Nums
	The number of records or rows in a list that contain numeric data.

	StdDev
	An estimate of the standard deviation of a population, where the list is the sample.

	StdDevp
	The standard deviation of a population, where the list is the entire population.

	Var
	An estimate of the variance of a population, where the list is the sample.

	Varp
	The variance of a population, where the list is the entire population.


Logic Functions

	AND
	Returns TRUE if all its arguments are TRUE

AND(2+2=4, 2+3=5) equals TRUE

	FALSE
	Returns the logical value FALSE

FALSE( )

	IF
	Specifies a logical test to perform

IF(B2>C2,"Over Budget","OK") equals "Over Budget"

IF(B3>C3,"Over Budget","OK") equals "OK"

	NOT
	Reverses the logic of its argument

NOT(1+1=2) equals FALSE

	OR
	Returns TRUE if any argument is TRUE

OR(1+1=1,2+2=5) equals FALSE

	TRUE
	Returns the logical value TRUE

TRUE( )


Appendix C: Sample spreadsheets
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Formula result:  updated result depending on content of above chosen cells





Functions box:  Give a list of popular functions





Edit Formula:  Opens Formula Palette
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Fig 3: Anatomy of a formula





Description:  description of function





value_if_false:  value displayed if logical test is false





value_if_true:  value displayed if logical test is true





Logical test:  the function result depends on this





Formula bar:  Displays the contents of the cell (not result)





Parentheses enclose arguments





A comma separates each argument





=SUM(A10,B5:C10,50,37)





Arguments





Function name





Equal sign (if the function is at the beginning of the formula)





The Excel 2000 Standard and Formatting toolbars includes buttons for formatting data and cells.





The Name box indicates which cell is selected.





The Formula box shows the data in the cell.











Column and Row numbers make it easier to know where you are on the worksheet.








Use these buttons to keep track of worksheets in a workbook. Click the Sheet buttons to move from one worksheet to another.
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